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IMPORTANT

PRECAUTIONS

LANGUAGE

NMPEAYNPEXOEHUE
(BG)

Toea ynbTBaHe 3a paboTa e HaNM4YHO CaMO Ha aHITINNCKN e3UK.

*  Ako OOCTaBYMKBLT Ha ycryraTa Ha KIMeHTa usmucka apyr esuk,
3abIKEHNE Ha KIMEHTa e ja ocurypv npesos.

*  He uasnonasante obopyaBaHeTo, Nnpeaun ga Cte ce KOHCynTupanu u
pa3bpanu ynbTBaHeToO 3a paborTa.

* HecnasBaHeTo Ha ToBa npeaynpexaeHne Moxe aa foseae A0
HapaHsiBaHe Ha [OoCTaB4YMKa Ha ycryrarta, oneparopa Unu nauveHTa B
pesynTaT Ha TOKOB yAap, MexaHu4Ha Unu apyra onacHocT.
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UPOZORENJE
(HR)

Ovaj servisni priruénik dostupan je na engleskom jeziku.

* Ako davatelj usluge klijenta treba neki drugi jezik, klijent je duzan
osigurati prijevod.

* Ne poku$avajte servisirati opremu ako niste u potpunosti procitali i
razumijeli ovaj servisni priru¢nik.

« Zanemarite li ovo upozorenje, mozZe doci do ozljede davatelja usluge,
operatera ili pacijenta uslijed strujnog udara, mehanickih ili drugih rizika.

VYSTRAHA
(CS)

Tento provozni navod existuje pouze v anglickém jazyce.

» V pfipadé, Ze externi sluzba zakaznikim potfebuje navod v jiném
jazyce, je zajisténi prekladu do odpovidajiciho jazyka ukolem zakaznika.

* Nesnazte se o udrzbu tohoto zafizeni, aniz byste si pfecetli tento
provozni navod a pochopili jeho obsah.

» V pfipadé nedodrzovani této vystrahy mize dojit k poranéni pracovnika
prodejniho servisu, obsluzného personalu nebo pacientu vlivem

elektrického proudu, respektive vlivem mechanickych ¢&i jinych rizik.
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ADVARSEL
(DA)

Denne servicemanual findes kun pa engelsk.

Hvis en kundes tekniker har brug for et andet sprog end engelsk, er det
kundens ansvar at sgrge for overseettelse.

Forsag ikke at servicere udstyret uden at laese og forsta denne
servicemanual.

Manglende overholdelse af denne advarsel kan medfere skade pa
grund af elektrisk stazd, mekanisk eller anden fare for teknikeren,
operatgren eller patienten.

WAARSCHUWING
(NL)

Deze onderhoudshandleiding is enkel in het Engels verkrijgbaar.

Als het onderhoudspersoneel een andere taal vereist, dan is de klant
verantwoordelijk voor de vertaling ervan.

Probeer de apparatuur niet te onderhouden alvorens deze
onderhoudshandleiding werd geraadpleegd en begrepen is.

Indien deze waarschuwing niet wordt opgevolgd, zou het
onderhoudspersoneel, de operator of een patiént gewond kunnen raken
als gevolg van een elektrische schok, mechanische of andere gevaren.

WARNING
(EN)

This service manual is available in English only.

If a customer's service provider requires a language other than English,
it is the customer's responsibility to provide translation services.

Do not attempt to service the equipment unless this service manual has
been consulted and is understood.

Failure to heed this warning may result in injury to the service provider,

operator or patient from electric shock, mechanical or other hazards.

HOIATUS
(ET)

See teenindusjuhend on saadaval ainult inglise keeles.

Kui klienditeeninduse osutaja nduab juhendit inglise keelest erinevas keeles,
vastutab klient tdlketeenuse osutamise eest.

Arge iiritage seadmeid teenindada enne eelnevalt kiiesoleva teenindusjuhendiga
tutvumist ja sellest aru saamist.

Kéesoleva hoiatuse eiramine voib pohjustada teenuseosutaja, operaatori voi
patsiendi vigastamist elektrilddgi, mehaanilise voi muu ohu tagajérjel.

VAROITUS
(F1)

Tama huolto-ohje on saatavilla vain englanniksi.

Jos asiakkaan huoltohenkildstd vaatii muuta kuin englanninkielistd materiaalia,
tarvittavan kadnnoksen hankkiminen on asiakkaan vastuulla.

Al4 yriti korjata laitteistoa ennen kuin olet varmasti lukenut ja ymmartinyt
tdmén huolto-ohjeen.

Mikali tiatd varoitusta ei noudateta, seurauksena voi olla huoltohenkiloston,
laitteiston kédyttdjén tai potilaan vahingoittuminen sdhkoéiskun, mekaanisen vian
tai muun vaaratilanteen vuoksi.

ATTENTION
(FR)

Ce manuel d’installation et de maintenance est disponible uniquement en
anglais.

Si le technicien d'un client a besoin de ce manuel dans une langue autre
que l'anglais, il incombe au client de le faire traduire.

Ne pas tenter d'intervenir sur les équipements tant que ce manuel
d’installation et de maintenance n'a pas été consulté et compris.

Le non-respect de cet avertissement peut entrainer chez le technicien,
I'opérateur ou le patient des blessures dues a des dangers électriques,
mécaniques ou autres.
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WARNUNG
(DE)

Diese Serviceanleitung existiert nur in englischer Sprache.

« Falls ein fremder Kundendienst eine andere Sprache bendtigt, ist es
Aufgabe des Kunden fur eine entsprechende Ubersetzung zu sorgen.

* Versuchen Sie nicht diese Anlage zu warten, ohne diese
Serviceanleitung gelesen und verstanden zu haben.

+ Wird diese Warnung nicht beachtet, so kann es zu Verletzungen des
Kundendiensttechnikers, des Bedieners oder des Patienten durch
Stromschlage, mechanische oder sonstige Gefahren kommen.

NMPOEIAOMNOIHZH
(EL)

To mapoév eyxelpidio ag€pPig diaTiBeTal pévo aTa ayyAIkd.

* Edv o texvikOg 0€pPIg evog TTEAATN aTTaiTel TO TTAPOV €yXEIPIDIO O€
YAWOOA €KTOG TwV AYYAIKWYV, aTTOTEAET EUBUVN TOU TTEAGTN VA TTAPEXE! TIG
UTTNPETiEG HETAPPAONG.

*  Mnv emIXEIPAOCETE TNV EKTEAEDN EPYACIWV TEPPIS OTOV £COTTAIGHO av dev
EXETE OUPPBOUAEUTEI Kal KATavoNoel TO TTapOV eyXelpidlo oépPIg.

* Av dev TTIPOCEEETE TNV TTPOEIDOTTOINCN AUTH, EVOEXETAI va TTPOKANBEI
TPAUMPATIONOG GTOV TEXVIKO O£PPIG, OTO XEIPIOTA 1} 0ToV aoBevh atrd
NAekTpOTTANEia, unxavikoug i GAAoug KivdUvoug.

FIGYELMEZTETES
(HU)

Ezen karbantartasi kézikonyv kizarélag angol nyelven érhet6 el.

+ Ha a vevé szolgaltatdja angoltdl eltéré nyelvre tart igényt, akkor a vevé
feleléssége a forditas elkészittetése.

* Ne probalja elkezdeni hasznalni a berendezést, amig a karbantartasi
kézikonyvben leirtakat nem értelmezték.

+ Ezen figyelmeztetés figyelmen kivul hagyasa a szolgaltato, mikodtetd
vagy a beteg aramutés, mechanikai vagy egyéb veszélyhelyzet miatti
sérulését eredményezheti.

ADPVORUN
(1S)

Pessi pjonustuhandbdk er adeins faanleg a ensku.

« Ef ad pjonustuveitandi vidskiptamanns parfnast annas tungumals en
ensku, er pad skylda vidskiptamanns ad skaffa tungumalapjonustu.

* Reynid ekki ad afgreida taekid nema ad pessi pjonustuhandbdk hefur
verid skodud og skilin.

» Brot a sinna pessari advorun getur leitt til meidsla a pjonustuveitanda,
stjornanda eda sjuklings fra raflosti, vélraenu eda 6drum ahaettum.

AVVERTENZA
(IT)

Il presente manuale di manutenzione & disponibile soltanto in lingua inglese.

* Se un addetto alla manutenzione richiede il manuale in una lingua
diversa, il cliente & tenuto a provvedere direttamente alla traduzione.

* Procedere alla manutenzione dell'apparecchiatura solo dopo aver
consultato il presente manuale ed averne compreso il contenuto.

* Il mancato rispetto della presente avvertenza potrebbe causare lesioni
all'addetto alla manutenzione, all'operatore o ai pazienti provocate da
scosse elettriche, urti meccanici o altri rischi.

RN
(JA)

uobooobobooobooobboooboaon

uoboboodbbooobbooobbooobbuooobbooon
uobbooobooobbooobood
oobobooobooobboobobooobbooon
HEN
HEN
HEN

HRN
gd
gd
gd oo ooo
gd oo ooo
4
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BRIDINAJUMS ST apkopes rokasgramata ir pieejama tikai anglu valoda.
(LV) » Jaklienta apkopes sniedzg&jam nepiecieSama informacija cita valoda, klienta
pienakums ir nodrosinat tulkojumu.

* Neveiciet aprikojuma apkopi bez apkopes rokasgramatas izlasiSanas un
saprasSanas.

« S7 bridindjuma neievéro$anas rezultata var rasties elektriskas stravas trieciena,
mehanisku vai citu faktoru izraisTtu traumu risks apkopes sniedzgjam,
operatoram vai pacientam.

ISPEJ IMAS Sis eksploatavimo vadovas yra tik angly kalba.
(LT) » Jei kliento paslaugy tiekéjas reikalauja vadovo kita kalba — ne angly, suteikti
vertimo paslaugas privalo klientas.

» Nemeéginkite atlikti jrangos techninés prieziiiros, jei neperskaitéte ar
nesupratote §io eksploatavimo vadovo.

» Jei nepaisysite Sio jspéjimo, galimi paslaugy tiekéjo, operatoriaus ar paciento
suzalojimai dél elektros Soko, mechaniniy ar kity pavojy.

ADVARSEL Denne servicehandboken finnes bare pa engelsk.
(NO) » Hvis kundens serviceleverandar har bruk for et annet sprak, er det
kundens ansvar a sgrge for oversettelse.

+ |kke forsgk a reparere utstyret uten at denne servicehandboken er lest
og forstatt.

* Manglende hensyn til denne advarselen kan fare til at
serviceleverandgren, operatgren eller pasienten skades pa grunn av
elektrisk stat, mekaniske eller andre farer.

OSTRZEZENIE Niniejszy podrecznik serwisowy dostepny jest jedynie w jezyku angielskim.
(PL) + Jedli serwisant klienta wymaga jezyka innego niz angielski, zapewnienie
ustugi ttumaczenia jest obowigzkiem klienta.

* Nie prébowac serwisowac urzgdzenia bez zapoznania sie z niniejszym
podrecznikiem serwisowym i zrozumienia go.

* Niezastosowanie sie do tego ostrzezenia moze doprowadzi¢ do obrazen
serwisanta, operatora lub pacjenta w wyniku porazenia prgdem
elektrycznym, zagrozenia mechanicznego bgdz innego.

ATENQAO Este manual de assisténcia técnica encontra-se disponivel unicamente em
(PT-BR) noles. . o

» Se outro servigco de assisténcia técnica solicitar a traducao deste
manual, cabera ao cliente fornecer os servigos de tradugao.

* Nao tente reparar o equipamento sem ter consultado e compreendido
este manual de assisténcia técnica.

* A nao observancia deste aviso pode ocasionar ferimentos no técnico,
operador ou paciente decorrentes de choques elétricos, mecanicos ou
outros.

Page 8
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ATENCAO
(PT-PT)

Este manual de assisténcia técnica so se encontra disponivel em inglés.

» Se qualquer outro servico de assisténcia técnica solicitar este manual
noutro idioma, é da responsabilidade do cliente fornecer os servigos de
traducao.

* Nao tente reparar o equipamento sem ter consultado e compreendido
este manual de assisténcia técnica.

» O nao cumprimento deste aviso pode colocar em perigo a seguranca do
técnico, do operador ou do paciente devido a choques eléctricos,
mecanicos ou outros.

ATENTIE
(RO)

Acest manual de service este disponibil doar in limba engleza.

» Daca un furnizor de servicii pentru clienti necesita o alta limba decat cea
engleza, este de datoria clientului sa furnizeze o traducere.

* Nu incercati sa reparati echipamentul decéat ulterior consultarii si
intelegerii acestui manual de service.

+ Ignorarea acestui avertisment ar putea duce la ranirea depanatorului,
operatorului sau pacientului in urma pericolelor de electrocutare,
mecanice sau de alta natura.

OCTOPOXHO!
(RU)

,D,aHHoe PYKOBOACTBO NO TEXHNYECKOMY O6CJ'Iy)KVIBaHI/II'O npeacrtaBneHo
TONbKO Ha aHIMNNCKOM SA3bIKE.

* Ecnu cepBucHomy nepcoHarny knmeHTa HeobxoaMmMo pyKOBOACTBO He Ha
AHITIMNCKOM, @ Ha KaKOM-TO ipYroM A3bIKe, KIMEHTY crneayeT
camocToATenNbHO obecneynTb NepeBo.

» [lepen TexHnyeckum obenyxuneaHmem obopynoBaHnsa obsi3aTernibHO
obpaTtutechb k JaHHOMY PYKOBOACTBY U MONMUTE U3NOXKEHHbIE B HEM
cBefeHus.

* HecobniogeHne TpeboBaHn AaHHOIO NpeaynpeXxaeHns MoXxeT
NPUBECTU K TOMY, YTO CNELMANUCT NO TEXOOCNYXXMBaHMIO, ONepaTop Unm
NauneHT NOMyYuT yaap arnekTpUYecKMM TOKOM, MEXaHUYECKYO0 TpaBMy
Unn 4pyroe noBpexaeHue.

UPOZORENJE
(SR)

Ovo servisno uputstvo je dostupno samo na engleskom jeziku.

» Ako klijentov serviser zahteva neki drugi jezik, klijent je duzan da
obezbedi prevodilacke usluge.

* Ne pokuSavajte da opravite uredaj ako niste procitali i razumeli ovo
servisno uputstvo.

* Ne pokusavajte da opravite uredaj ako niste procitali i razumeli ovo
servisno uputstvo.

UPOZORNENIE
(SK)

Tento navod na obsluhu je k dispozicii len v anglictine.

+ Ak zakaznikov poskytovatel sluzieb vyzaduje iny jazyk ako angli¢tinu,
poskytnutie prekladatelskych sluZieb je zodpovednostou zakaznika.

* Nepokusajte sa o obsluhu zariadenia, kym si neprecitate navod na
obluhu a neporozumiete mu.

+ Zanedbanie tohto upozornenia méze spbsobit zranenie poskytovatela
sluzieb, obsluhujucej osoby alebo pacienta elektrickym prudom,
mechanickeé alebo iné ohrozenie.

Important Precautions Page 9
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ATENCION
(ES)

Este manual de servicio sdlo existe en inglés.

Si el encargado de mantenimiento de un cliente necesita un idioma que
no sea el inglés, el cliente debera encargarse de la traduccién del
manual.

No se debera dar servicio técnico al equipo, sin haber consultado y
comprendido este manual de servicio.

La no observancia del presente aviso puede dar lugar a que el
proveedor de servicios, el operador o el paciente sufran lesiones
provocadas por causas eléctricas, mecanicas o de otra naturaleza.

VARNING
(SV)

Den har servicehandboken finns bara tillganglig pa engelska.

Om en kunds servicetekniker har behov av ett annat sprak an engelska,
ansvarar kunden for att tillhandahalla éversattningstjanster.

Forsok inte utfora service pa utrustningen om du inte har last och forstar
den har servicehandboken.

Om du inte tar hansyn till den har varningen kan det resultera i skador pa
serviceteknikern, operatoren eller patienten till féljd av elektriska stotar,
mekaniska faror eller andra faror.

OPOZORILO
(SL)

Ta servisni priro€nik je na voljo samo v angleSkem jeziku.

Ce ponudnik storitve stranke potrebuje priroénik v drugem jeziku, mora
stranka zagotoviti prevod.

Ne posku$ajte servisirati opreme, Ce tega priro¢nika niste v celoti
prebrali in razumeli.

Ce tega opozorila ne upostevate, se lahko zaradi elektri¢nega udara,
mehanskih ali drugih nevarnosti poskoduje ponudnik storitev, operater
ali bolnik.

DIKKAT
(TR)

Bu servis kilavuzunun sadece ingilizcesi mevcuttur.

Eger musteri teknisyeni bu kilavuzu ingilizce diginda bir bagka lisandan
talep ederse, bunu tercime ettirmek musteriye diger.

Servis kilavuzunu okuyup anlamadan ekipmanlara midahale etmeyiniz.
Bu uyariya uyulmamasi, elektrik, mekanik veya diger tehlikelerden
dolayi teknisyen, operatdr veya hastanin yaralanmasina yol acabilir.

Page 10
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DAMAGE IN TRANSPORTATION

All packages should be closely examined at time of delivery. If damage is apparent, have notation
“‘damage in shipment” written on all copies of the freight or express bill before delivery is accepted
or “signed for” by a General Electric representative or a hospital receiving agent. Whether noted or
concealed, damage MUST be reported to the carrier immediately upon discovery, or in any event,
within 14 days after receipt, and the contents and containers held for inspection by the carrier. A
transportation company will not pay a claim for damage if an inspection is not requested within this
14 day period.

To file a report:

. Call 1-800-548-3366 and use option 8.

. Fill out a report on http://us44hdd21/sctg/InstallF ulfill/InstalFulfillment.htm

+  Contact your local service coordinator for more information on this process.

Rev. Jan. 5, 2005

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT

All electrical Installations that are preliminary to positioning of the equipment at the site prepared
for the equipment shall be performed by licensed electrical contractors. In addition, electrical feeds
into the Power Distribution Unit shall be performed by licensed electrical contractors. Other
connections between pieces of electrical equipment, calibrations and testing shall be performed by
qualified GE Medical personnel. The products involved (and the accompanying electrical
installations) are highly sophisticated, and special engineering competence is required. In
performing all electrical work on these products, GE will use its own specially trained field
engineers. All of GE’s electrical work on these products will comply with the requirements of the
applicable electrical codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers,
personnel of third-party service companies with equivalent training, or licensed electricians) to
perform electrical servicing on the equipment.

IMPORTANT...X-RAY PROTECTION

X-ray equipment if not properly used may cause injury. Accordingly, the instructions herein
contained should be thoroughly read and understood by everyone who will use the equipment
before you attempt to place this equipment in operation. The General Electric Company, Medical
Systems Group, will be glad to assist and cooperate in placing this equipment in use.

Although this apparatus incorporates a high degree of protection against x-radiation other than the
useful beam, no practical design of equipment can provide complete protection. Nor can any
practical design compel the operator to take adequate precautions to prevent the possibility of any
persons carelessly exposing themselves or others to radiation.

It is important that anyone having anything to do with x-radiation be properly trained and fully
acquainted with the recommendations of the National Council on Radiation Protection and
Measurements as published in NCRP Reports available from NCRP Publications, 7910 Woodmont
Avenue, Room 1016, Bethesda, Maryland 20814, and of the International Commission on
Radiation Protection, and take adequate steps to protect against injury.

The equipment is sold with the understanding that the General Electric Company, Medical Systems
Group, its agents, and representatives have no responsibility for injury or damage which may result
from improper use of the equipment.

Various protective materials and devices are available. It is urged that such materials or devices be
used.

Important Precautions Page 11
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CAUTION

ATTENTION

LITHIUM BATTERY CAUTIONARY STATEMENTS

Risk of Explosion.

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard
used batteries according to the manufacturer’s instructions.

Danger d’Explosion

Il y a danger d’explosion s’il y a replacement incorrect de la batterie.

Remplacer uniquement avec une batterie du méme type ou d’un type recommandé par le
constructeur. Mettre au rébut les batteries usagées conformément aux instructions du
fabricant.

OMISSIONS & ERRORS

Customers, please contact your GE Sales or Service representatives.

GE personnel, please use the Healthcare PQR Process to report all omissions, errors, and defects
in this publication.

Page 12
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Revision History

Revision

Date

Reason for change

2

April 13, 2016 Chapter 2, Section 2: Added sub-section 2.4.

1

October 23, 2014 | Initial Release

Revision History
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Preface

Publication Conventions

Purpose: Standardize conventions for representing information is a uniform way of communicating
information to a reader in a consistent manner. Conventions are used so that the reader can easily
recognize the actions or decisions that must be made. There are a number of character and
paragraph styles used in this publication to accomplish this task. Please become familiar with them
before proceeding forward.

Section 1.0
Safety & Hazard Information

1.1 Text and Character Representation

DANGER
SEVERE
PERSONAL
INJURY

WARNING
SERIOUS
PERSONAL
INJURY

Within this publication, different paragraph and character styles have been used to indicate potential
hazards. Paragraph prefixes, such as hazard, caution, danger and warning, are used to identify
important safety information. Text (Hazard) styles are applied to the paragraph contents that is
applicable to each specific safety statement. Words describe the type of potential hazard that may
be encountered and are placed immediately before the paragraph it modifies. Safety information
will normally include:

Type of potential Hazard

Nature of potential injury

Causative condition

How to avoid or correct the causative condition

EXAMPLES OF HAZARD STATEMENTS USED

I's important that you read and understand hazard statements, and not just ignore them.

DANGER IS USED WHEN A HAZARD EXISTS WHICH WILL CAUSE SEVERE
PERSONAL INJURY OR DEATH IF INSTRUCTIONS ARE IGNORED. THEY
CAN INCLUDE:

* ELECTROCUTION

* CRUSHING

* RADIATION

WARNING IS USED WHEN A HAZARD EXISTS WHICH COULD OR CAN CAUSE
SERIOUS PERSONAL INJURY OR DEATH IF INSTRUCTIONS ARE IGNORED. THEY
CAN INCLUDE:

* POTENTIAL FOR SHOCK
» EXPOSED WIRES

* FAILURE TO TAG AND LOCKOUT SYSTEM POWER COULD ALLOW FOR
UN-COMMANDED MOTION.
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CAUTION Caution is used when a hazard exists which can or could cause minor injury to self or others
Minor  if instructions are ignored. They include for example:
Perlsc.)nal *  Loss of critical patient data
njury . Crush or pinch points
e  Sharp objects
NOTICE Notice is used when a hazard is present that can cause property damage but has absolutely
Property no personal injury risk.They can include:
Damage . pjsk drive will be destroyed
Only

. Internal mechanical damage, such as to the x-ray tube
*  Coasting the rotor through resonance.

1.2 Graphical Representation

Important information will always be preceded by the exclamation point ﬁ contained within a
triangle, as seen throughout the Preface chapter. In addition to text, several different graphical icons
(symbols) may be used to make you aware of specific types of hazards that could possibly cause
harm.

HAZARDS
ELECTRICAL MECHANICAL RADIATION
g Y
’l '{}"“% a

LASER HEAT PINCH
E%% LASER
LIGHT

PROCEDURAL
AVOID STATIC ELECTRICITY TAG AND LOCK OUT WEAR EYE PROTECTION

EYE
PROTECTION

£a
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Section 2.0
Publication Conventions

2.1 General Paragraph and Character Styles

Note:

Example:

Comment:

Prefixes are used to highlight important non-safety related information. Paragraph prefixes (such as
purpose, example, comment or note) are used to identify important but non-safety related
information. Text styles are also applied to text within each paragraph modified by the specific
prefix.

EXAMPLES OF PREFIXES USED FOR GENERAL INFORMATION

Purpose: Introduces and provides meaning as to the information contained within the
chapter, section or subsection, Such as used at the beginning this chapter for example.

Conveys information that should be considered important to the reader.

Used to make the reader aware that the paragraph(s) that follow are examples of information
possibly stated previously.

Represents “additional” information that may or may not be relevant to your situation.

2.2 Page Layout

Publication Part Number & Revision Number Publication Title

[ — f e
DreononZ12915-100 Bewaons Gaera. Svo Seroe Meus. Dreonowz152972-100, BeweoHS
i pe—— @

B nanangrass. aonse,

n
10) Fesssentio Garey. oonen,ana

322 4526676561 Imercom Circit Board o
1) Morobibie olonsst dovaticn. <
2) Tun atectty ponsets POLL

+

DANGER  USE TAG AND LOCK OUT PROCEDURE. ) endthetleck il BAOCH.
7% 3y Peanove giney sive cores. 18) Peasscantio: Gariy.
5

ZEUS REMOTE INTERCOM X
46-288766 G1-C

H
H

90 141 REMOTEINTERGOM X BOARD
923  46297400P1 Rear Microphone: _
1) Morobio ot dorten 325 mlmm}(h::llmhms
2) Tun atesiiy powsetoFELL T o e
USE TAG AND LOCK QUT PROCEDURE. T T Line v arautinp

T,

327 Remo Imercom X Brard Swith Settings.
hers

== 11\ il

The current chapter and its title -~

are always shown in the footer of

the right (odd) page.

Paragraphs preceeded by a symbol
L (e.g. bullets) contain information that

has no specific order.

5 .
The current section and its title

are always shown in the footer of
the left (even) page.

An exclamation point in a triangle is used
-to indicate important information to the user.

Paragraphs preceeded by Alphanumeric
characters (e.g. numbers) contain infor- —
mation that must be followed in a specific order.

Headers and footers in this publication are designed to allow you to quickly identify your location.
The document’s part number and revision number appears in every header on every page. Odd
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numbered page footers indicate the current chapter, its title and current page number. Even page
footers show the current section and its title, as well current page number.

2.3 Computer Screen Output/Input Text Character Styles

Example:
Fixed Output

Example:
Variable Output

Example:
Fixed Input

Example:
Variable Input

Within this publication, mono-spaced character styles (fonts) are used to indicate computer text
that’s either screen input and output. Mono spaced fonts, such courier, are used to indicated text
direction. When you type at your keyboard, your are generating computer input. Occasionally you
will see the math operators “greater than” and “less than” symbols used to indicate the start and
finish of variable output. When reading text generated by the computer, you are reading it as
computer generated output. In addition to direction, characters are italicized (e.g. italics) to indicate
information specific to your system or site.

This paragraph’s fonts represents computer generated screen “fixed”
output. It’s output is fixed from the sense that it does not wvary from
application to application. It’s the most commonly used style used to
indicate filenames, paths and text that does not change form system to
system. The character style used is a fixed width such as courier.

This paragraph’s font represents computer screen output that is
“variable”. Its used to represent output that varies from application to
application or system to system. Variable output is sometimes found placed
between greater than and lesser than operators for clarification. For
example: <variable ouput> or <3.45.120.3>. In both cases, the < and >
operators are not part of the actual input.

This paragraph’s font represents fixed input. It’s computer input that is
typed-in via the keyboard. Typed input that does not vary from application
to application or system to system. Fixed text the user is required to
supply as input. For example: cd /usr/3p

This paragraph’s font represents computer input that can vary from
application to application or system to system. With variable text, the
user is required to supply system dependent input or information. Variable
input sometimes is placed between greater-than and less-than operators.
For example: <variable input>. In these cases, the (<>) operators would
be dropped prior to input. For example: ypcat hosts | grep <3.45.120.3>
would be typed into the computer as ypcat hosts | grep 3.45.120.3 without
the greater-than and less-than operators.

2.4 Buttons, Switches and Keyboard Inputs (Hard & Soft Keys)

Example:
Hard Keys

Example:
Soft Keys

Different character styles are used to indicate actions requiring the reader to press either a hard or
soft button, switch or key. Physical hardware, such as buttons and switches, are called hard keys
because they are hard wired or mechanical in nature. A keyboard or on/off switch would be a hard
key. Software or computer generated buttons are called soft keys because they are software
generated. Software driven menu buttons are an example of such keys. Soft and hard keys are
represented differently in this publication.

A power switch ON/OFF or a keyboard key like ENTER is indicated by applying a character style
that uses both over and under-lined bold text that is bold. This is a hard key.

Whereas the computer MENU button that you would click with your mouse or touch with your hand
uses over and under-lined regular text. This is a soft key.

END OF SECTION
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Chapter 1
Introduction

Section 1.0
Personnel Requirements

Required Persons | Preliminary Reqs | Procedure | Finalization
1 | Timing Not Applicable | 200 mins. | 20 mins

Section 2.0
Overview

This procedure describes the necessary steps to upgrade the Optima CT660 Phase 1.5
(10HW33.8) system to Optima CT660 Phase 2.5 (14HW30.x) system.

Phase 2.5 IBUpgrade Kit Installation

[ Preparation

[[J Host C omput er BIOS Upg rade

[JRAID Firmware Upgrade

[JFDIP Firmware Upgrade

[[1 14HW30.x L oad fr om C old (LFC menu)
[Jinstall Additional Option Keys for Phase 2.5
[Jinstall eLicense Key for new Volume Viewer Applications
[JGLU Firmware Upgrade

[JTube Installation Certi cation

[J Flash Download

[ Save System State

[J Quality Assurance Test

[J Finalization

Figure 1-1 Procedure Flow
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Section 3.0
Preliminary Requirements

3.1 Tools and Test Equipment

Item ‘ Qty. ‘ Effectivity ‘ Part No. ‘ Manufacturer
Standard FE Tool Kit ‘ 1 ‘ - ‘ - ‘ -
3.2 Consumables
Item | Qty. | Effectivity | PartNo. |  Manufacturer

None ‘ 1 ‘ - ‘ - ‘ -
3.3 Safety

No general safety information.
3.4 Required Conditions

Condition Reference | Effectivity

Only trained service personnel should service the GE CT Scanner. - -
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Section 4.0
Material List

Mark No. |Name Description Quantity
5460670-2
1 5461931 GLU OS Upgrade Kit for Cj2.5 1
1 5332268-2 Compact Flash Memory for GLU 1
2 5443140 GLU rev3 Label for Cj2.5 GLU upgrade kit 1
3 5455847 GLU rev4 Label for Cj2.5 GLU upgrade kit 1
2 5437815 Optima CT660 Phase 2.5 Hardware Update CD Collector with Jewel Case 1
1 5439379 Optima CT660 Phase 2.5 BIOS Update Disk 1 1
2 5439379-2 Optima CT660 Phase 2.5 RAID_FDIP Firmware Update Disk 1
3 5439379-3 Optima CT660 Phase 2.5 BIOS Update Disk 2 1
3 5366514-3 Cable, USB_Extend, SSA key 1
4 5599284-1EN Optima CT660 Phase 2.5 IB Upgrade Kit Installation 1
5 5389067-9 Cj P2.5 Software Collector with Rating Plate 1
6 5375974-6 Optima CT660 Upgrade Doc Collector 1
7 5566025-500 Optima CT660 P25 Base Upgrade Product Key 1
8 5405579 DVD RAM Bare Media 1
9 5549276-1EN Optima CT660 Upgrade Feature Overview 1
12 5480528-3 Z800 Part Label 1

Table 1-1 Optima CT660

Phase 2.5 Upgrade Kit
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This Page Intentionally Blank.
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Chapter 2

Upgrade Procedure

Section 1.0
Procedure

1.1 Preparation

1.1.1 Record Customer Options and Settings

1.) Record the option keys installed in the system.

I e o o o o o (|

Patient-64-Slice
Direct-MPR

Data Export
SmartPrep

AutomA

3000 Image Series
CopyComposer
SmartSpeed

ASIR

NeuroFilter

75kVA

90kVA

100kVA

Dynamic Z-axis Tracking
0 _4Speed
Sub-0.4-Second-Scan
Overlapped Recon - Axial
Connect Pro

Exam Split
SmartScore Pro
CardIQ SnapShot
EKG Viewer

Noise Reduction Filter
CardlQSnapShot-Cine
DentaScan
VolumeViewer
CardEP

CardIQPlus *
AdvVesselAnalysis *

OOooOoooooooaa

AutoBone *

CTColonoPro *

CTPerfusion4 *

CTPerfusion4 Neuro *
SmartStep

AxialShuttle

HelicalShuttle

Xtream Injector

Enhanced Xtream Injector
Enhanced Rotor Management
Enhanced Rotor Management-DS

*Requires regeneration of the option Key by eLICense. (Refer to section 1.1.4 for the details.)
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2.) Record the Archive Node setting in Remote host parameters screen.

a.) InImage Works desktop, select Network --> Selected Remote Host --> Update

Figure 2-1 Window - Remote Host Parameters

b.) Record the Archive Node setting (Auto/Yes/No) in the screen.
c.) Record the settings of other remote hosts if multiple hosts are connected to the system.

Note:  The Phase 2.5 software only provides 2 selections, Yes or No, for the Archive Node setting. Setting
of Phase 1.5 will be converted as follows.

Phase 1.5 Phase 2.5
Auto S Yes

Yes S Yes

No S No
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1.1.2

Note:

1.1.3

1.1.4

Note:

Note:

Check Default Gateway IP Address

1.) Shut down Applications from the Common Service Desktop, Utilities Tab.
2.) Open a Terminal Window, and log on as root:
Type: {ctuser@hostname} su - [ENTER]
Type the root password and press [ENTER]
3.) Launch the Configuration utility:
Type: [root@hostname] reconfig [ENTER]
4.) Click [NETWORK] to display the Network Settings Screen.

5.) Check the Default Gateway field. If "0.0.0.0" is used, clear the settings according to Appendix
A.

If "0.0.0.0" is entered in Default Gateway field, option software installation may fail.

Confirm the setLoadHeight status

Confirm current setting of setLoadHeight. That is used to customize the cradle load height. Refer
to Appendix B of this manual how to do that.

Generate eLicense Key for new Volume Viewer Applications

If your system has the following Volume Viewer application software keys, they are not compatible
with Phase 2.5 software.

Generate compatible option keys by using eLicense web tool.
http://elicense.gehealthcare.com/elicense/

Option name Phase1.5 Phase2.5
B7870JB CardlQ Plus CardIQPlus CardlQ_Xpress_Reveal
B7870JC Advanced Vessel Analysis |AdvVesselAnalysis AVA_Xpress
B7870JD AutoBone AutoBone AutoBone_Xpress
B7864KL CTC Pro on OC CTColonoPro CT_Colono_Pro3D_EC
B7870HM CTPerfusion4 CTPerfusion4 CT_Perfusion_4D_MultiOrgan
B7870HN CTPerfusion4Neuro CTPerfusion4Neuro CT_Perfusion_4D_Neuro

Table 2-1 Option Key Compatibility

The eLicence web tool for Optima CT660 was set up to generate both existing elicense key and
new elicense key for Phase 2.5.

Catalog Description Floatabl Application Name/Key/Number of Users
ID e
B7870JC B7870JC Advanced N AdvVesselAnalysis permanent 0 00b96c49f5811000000001700
Vessel Analysis AVA_Xpress permanent 0 0273269d5f511000000000658

able 2-2 Example of eLicense Key

You will need to obtain the following information prior to generate the eLicence key.
- GON (Global Order Number) of the CT system
- Host ID of the host computer (This can be obtained by executing check_config command
in Unix shell.)

For the details on the eLicense tool, register CT E-LICENSE TRAINING (COURSE ID: GEHC-
TECH-AMOL-CT6002) in GE Learning.
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1.1.5 Remove Option Keys for Volume Viewer Application Software

If your system has option keys listed in Table 2-1, remove them by Install Options (Service >
Configuration - Install Options).

1.1.6 Save System State

1.) Go to Service Desktop - Ultilities
2.) Execute Save System State.

Note: Save two sets of System State and keep one set as backup.
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1.2 Host Computer BIOS Upgrade

Note:

BIOS update disk 2 is not used in this upgrade. It is provided for downgrading the Host BIOS to
original version.

1.) Insert the Optima CT660 Phase 2.5 BIOS Update Disk 1 into the Host Computer DVD Drive.
2.) Shut down the system and recycle the console power.

3.) Press <F10> when HP logo is displayed.

4.) Inthe F10 setup utility, select Storage - Storage Options > SATA Emulation > IDE

Heulett-Packard
Security Pouwer Advanced

Device CunI'iEEurai ion

Removable Media Boot  Emable
Legacy Diskette Urite  Enable
SATA Emulation MDE

Figure 2-2 Screen - Setup Utility

5.) Press <F10> to accept the change.
6.) Select File > Save Changes and Exit and hit <Enter>.
7.) Press <F10> to accept the change.

. Systen Information
fibout

System Temperatures Save Changes and Exit —

Set Tine and Date fire you sure you want to
Flash Systen RON Save Changes and Exit?

Replicated Setup F18=Yes, ESC-Ho

Default Setup
|

fipply Defaults and Exit
I 3

| CFR=Lanmianey

Figure 2-3 Screen - Save Changes and Exit
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8.)
9.)

In the F10 setup utility, select File > Flash System ROM
Select CD-ROM in the Flash System ROM window and press <F10>.

. Heulett-Packard Setup Utilit
@ Storage Security FPower Advanced

! Systen Information
About

Systen Temperatures Flash Systea ROM
Set Time and Date Select a drive:

Flash System RON
16=Accept, ESC=Cancel

Replicated Setup

Default Setup

Apply Defaults and Exit
Ignore Changes and Exit
Save Changes and Exit

Figure 2-4 Screen - Flash System ROM

10

.) Select 7G5_0321.BIN and press <F10>.

Heulett-Packard Setup Utilit:
(W Storage Security Power Advanced

| Systen Information
fAbout

Systen Temperatures Flash Systes RON
Set Time and Date Select a file:

Flash System RON

Replicated Setup

16=fccept, ESC=Cancel

Default Setup

fipply Defaults and Exit
Ignore Changes and Exit
Save Changes and Exit

Figure 2-5 Screen - File Selecting
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11.) Press <F10> in confirmation window.

Heulett-Packard Setup Utilit:
Storage Security Pouer Advanced

Systen Information
fibout

Systen Temperatures Flash Systea RON

Set T and Date fire you sure you vant to
Flash System ROM

Replicated Setup 78665 v3.87 -> v3.21

Default Setup F16=Yes, ESC=Ho

fipply Defaults and
Ignore Changes and Exit
Save Changes and Exit

Figure 2-6 Screen - Confirmation

12.) When Success message appears press any key to reboot the host computer.

Heulett-Packard Setup
[ Storage Security FPouer Advanced

| Systen Information
fibout

Systen Tenperatures

Success

Systen BOM Flash vas successful.
The system will now reboot.

Press any key to continue

Ignore Changes and Exit
Save Changes and Exit

Figure 2-7 Screen - Success Message
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13.) Press <F10> when HP logo is displayed.
14.) Set SATA Emulation option back to RAID+AHCI.

Select Storage > Storage Options > SATA Emulation > RAID+AHCI
15.) Press <F10> to accept the change.
16.) Select Power > OS Power Management - Runtime Power Management
17.) Select Disable.

Heulett-Packard Setup Utili
File Storage i Qo Advanced

05 Power Management
Harduare Pouer Managenent

Runtime Pover Management Misable
AL T-fuare 0S Enable

Idle Pover Savings Hornal

ACPL 53 Hard Disk Reset Disable
ACPI 53 PSZ NMouse Uake Up Disable
USB Uake on Device Imsertion Disable
Unique Sleep State Blink Rates  Disable

ficcept, ESC=Cancel

Figure 2-8 Screen - OS Power Management

18.
19.
20.
21.

Press <F10> to accept the change.

Select File > Save Changes and EXxit and hit <Enter>.

Press <F10> to accept the change.

Check that the BIOS version displayed on the lower left of HP blue screen indicates v03.21.

~— ~— ~— ~—

Press any key for Option ROM Messages
F9=Bont Menw) <F10=Setup:

Figure 2-9 Screen - BIOS Version

22.) Remove the BIOS update CD from Host Computer DVD Drive.
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1.3 RAID Firmware Update

1.) If Application software is up, perform Application Shutdown from Service Desktop - Utilities.
2.) Open a Unix shell and become root:

i.) {ctuser@hostname} su -
ii.) Password: <password>
3.) Perform the following command to check RAID firmware version.

i.) [root@hostnamel# MegaCli -AdpAllInfo -a0 -NoLog | grep "FW Version"
4.) Check the displayed FW Version.

i.) If the output is 1.40.282-1279, upgrade is not necessary. Go to section 1.5.

ii.) If the output is different from 1.40.282-1279, continue the following steps.
5.) Insert the Optima CT660 8888 RAID Firmware update CD into DVD drive in the host.
6.) Perform the following steps to update RAID firmware:

i.) [root@hostname]# mount /media/cdrom
ii.) [roote@ehostnamel# cd /media/cdrom/
Note:  Scan disk failure message will appear, but ignore it.
iii.) [roote@hostnamel# gre-raid -s
iv.) [root@hostname]# MegaCli -adpfwflash -f mr1078fw.rom -a0 -NoLog
v.) Confirm that the following message is displayed:
Adapter 0:Flash Completed
Exit Code: 0x00
Vi.) [root@hostnamel# reboot
7.) After the system startup, open a Unix Shell and become root in the Unix Shell.

i.) {ctuserehostname} su -
ii.) Password: <password>
8.) Perform the following command to check RAID firmware version.
[root@hostname] # MegaCli -AdpAllInfo -a0 -NoLog | grep "FW Version"
9.) Check the following output is shown.
FW Version : 1.40.282-1279
10.) Leave the Firmware update CD in DVD drive for FDIP firmware update in the next section.

1.4 FDIP Firmware Update

1.) Make sure the Optima CT660 8888 RAID Firmware update CD is still in the host DVD drive.
2.) Open a Unix shell and type the following and hit ENTER.

{ctuser@hostname} flash vdip -i
3.) Check that “load Rev:*“ number displayed in the output message.

i.) Ifitis “Oxa6”, upgrade is not necessary. Go to section 1.6.
ii.) Ifitis different from “Oxa6”, continue the following steps.
4.) Open a Unix shell and become root.

i.) {ctuser@hostname} su -
ii.) Password: <password>
5.) In Unix shell, perform the following.
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9.)

10.

11

12.

13.
14.
15.

16
17
18.
19
20

21.
22.

i.) {root@hostname} mkdir /usr/g/ctuser/fdip
ii.) {root@hostname} mount /mnt/cdrom

iii.) {root@hostname} cp -p /mnt/cdrom/5373033-2 r3.hexout /usr/g/
ctuser/fdip

iv.) {root@hostname} cd /usr/g/ctuser/fdip

v.) {root@hostname} md5sum 5373033-2 r3.hexout

Check that the value that is shown by the above command is as follows:
8cd323ed4ea93eb3a3a04e6395a54d37

If the value is different, repeat the step 5 again.

In Unix shell, type the following and hit ENTER.

{root@hostname} flash vdip -e -10 5373033-2_r3.hexout (-0 option means
lower-case of “L” and “zero”)

Type y and hit Enter if "Are you sure you want to do this ?" message appears.
) Wait a few minutes until FDIP Flash ROM process completes.

.) Confirm the update of Flash ROM has been completed correctly with "verify pass" message.

If "failed", return to step 8.
) In Unix shell, type the following and hit ENTER.

{root@hostname} flash vdip -e -11 5373033-2 r3.hexout (-I1 option means
lower-case of “L1”)

) Type y and hit Enter if "Are you sure you want to do this ?" message appears.
) Wait a few minutes until FDIP Flash ROM process completes.

) Confirm the update of Flash ROM has been completed correctly with "verify pass" message.
If "failed", return to step 12.

) Open a Unix shell and type: halt.

) Power OFF the console at the front panel switch.

) Power ON the console.

) Stop at application startup.

) Open a Unix shell and type the following and hit ENTER.
{ctuser@hostname} flash vdip -i

) Confirm that “load Rev: Oxa6” is displayed in the output message.

) Eject the firmware update CD from the host computer.

1.5 2Z800 Part Number Label Attachment

1)

Remove the existing part number label from Z800 computer and attach the 5700000-3 label
(P/N 5480528-3) which is included in this upgrade kit to the same location.

TITY

Part Number Label

Figure 2-10 Z800 Part Number Label
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1.6 14HW30.x Load from Cold

1.) Perform the following tasks according to (14HW30.x) Load From Cold procedure in Optima
CT660 Service Methods CD-ROM.

- OSLoad
- Apps Load
- Set Date and Time
- InstallClassC & M
- Restore system state
After completing “Restore System State”, exit LFC Menu and return to this manual.

2.) Reboot the system.

Note: Gantry LCD Unit will not boot up normally at this point due to application version mismatch between
gantry LCD unit and Host. It will be corrected after GLU firmware upgrade described at later section.

1on M
l:: m1LE F:i

ry LC

=
vk

Figure 2-11 Gantry LCD Version Mismatch Message
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3.) Check that all Archive Node settings are successfully restored/converted.
Go to Image Works. Select Tools--> Network Configuration

Figure 2-12 Window - Configure Network Hosts

Note:  The Phase 2.5 software only provides 2 selections, Yes or No, for the Archive Node setting. Setting
of Phase 1.5 will be converted as follows.

Phase 1.5 Phase 2.5
Auto S Yes

Yes S Yes

No S No
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1.7 Install Additional Option Keys for Phase 2.5

Install the following additional option keys included in the kit.
. Dynamic Z-axis Tracking

. Dynamic Transition

*  Auto Filter & Transfer (Non ASIR system only)

NOTICE  Auto Filter & Transfer is only applicable for non ASIR system. Do not install it to ASIR option
installed system.

1.8 Install eLicense Key for new Volume Viewer Applications

If you have generated eLicense Key(s) for new Volume Viewer applications at section 1.1.4, install
them at this timing.

1.) Open Install Options from Service > Configuration. Then select Install.

[10ptima CT660 SW Options |
| Hostname ibsviart ‘
Options ID 73e9e7ca

Installed Options

Option Name Moile Days Left
Patient-64-slice Permanent
Di rect-HPR Permanent
Data Export Permanent
Smart Prep Permanent
Automd Permanent
3000 Image Series Permanent
CopyComposer Permanent
NeuroFilter Permanent
ASIR Permanent
Smart Speed Permanent
0_4Speed Permanent
Sub-0.4-Second-Scan Permanent
100kva Permanent
SmartScore Pro Permanent
CardI} SnapShot Permanent
VolumeViever Permanent
AutoBone Permanent
AdvVesselAnalysis Permanent ¥

Figure 2-13 Install Option Window
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2.) Select Permanent

Figure 2-14 Selection Window - Permanent

3.) Select Manual

Figure 2-15 Selection Window - Manual

4.) Enter eLicense key string in ENTER THE LICENSE STRING window.

Figure 2-16 Window - eLicense Key Input

5.) Select [Quit] to exit Instal Options window.
6.) Reboot the system.

7.) After application is started up, check that all options are loaded by Verify Options in Common
Service Desktop - Configuration tab.
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1.9 GLU Firmware Upgrade

1.) Replace the Compact Flash Memory Card in Gantry LCD Unit with new one (P/N 5332268-2)
which is included in this upgrade kit. Refer to Xtream Display CF Memory Card Replacement
procedure in Optima CT660 Service Methods CD-ROM.

2.) Attach part number label onto the existing label on Gantry LCD Unit.

GPN/Revision of Gantry LCD Unit

New Label

5332266 rev8 or later
5332266-15 any revision

5332266-02 rev4

5332266 rev7 or earlier

5332266-02 rev3

ST i ;

Figure 2-17 Label Attachment

3.) Restore gantry left side cover and top covers.

4.) Turn ON the Axial Drive, HVYDC and 120 VAC switches on the gantry’s Service Switch Panel.

5.) Restore gantry right side cover.
6.) Turn ON the console power.
7.) Confirm the Gantry LCD unit starts up normally.

1.10 Tube Installation Certification

1.) Perform the Tube Install Certification procedure according to Tube Install Certification
procedure in Optima CT660 Service Methods CD-ROM.

2.) When completed, continue with Flash Download.
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1.11 Flash Download

1.) Perform the Flash Download Utility found on the Common Service Desktop - Utilities Tab,
select [Flash Download].

™ B

D. B Logs Disgnusics Unege Dty Caltusineg o i b [ Y Blariaimr it

) 50 7 E)
| =

v =

fericn 4 UtilitesfTools Sarvice Suocoess Command:
=3 FLASH Download Tool Remote Display i 127.0.0.1
% HHS S -

3 CT Mobile States: Sucossfully Requested SDM to start Ascig/bin/startFlashDosmload

DISPLAY: An

Connection errer: CTH_LTA

e -
i Pl Clmpuaer it

Figure 2-18 Common Service Desktop - Utilities Tab, Flash Download

Note: The Flash Download takes 5 - 30 minutes, depending on which subsystems need firmware
updating.

2.) When the Flash Download Window opens, Select [Update].

(LR TN Y Iraige Cha |8y LEr LT il L e

r r

Pl 16 170

Sz TSISN e 1mER

Figure 2-19 Flash Download Window
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3.) Once the Gantry Hardware Flash Downloads successfully, select [Dismiss].
4.) Close the Common Service Desktop.

5.) Reconnect the Hospital Network cable at the rear of the Operator Console that was
disconnected at the beginning of the LFC.

6.) Select Shutdown icon on the Desktop and restart the system.
1.12 InSite & iLinq Checkout

If the system has class M software and previously InSite and/or iLing was enabled, perform the
checkout at this time.

Note:  With new software version, system needs to be checked out with new model type “ SUSE IIP4”.
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Section 2.0
Finalization

21 Save System State

1.)
either DVD-RAM or USB Media.

2)
2.2 Quality Assurance Test

1.) Perform FastCal.

2)
CT660 Service Methods CD-ROM.

Perform the System State Save and Restore procedure and save a System State Backup to

Save the System State Backup media in a safe and secure location for future service activity.

Perform Quality Assurance Test according to Quality Assurance Test procedure in Optima

Note:

Dynamic Z-axis Tracking may effect on CT number for helical scan. If CT number for QA3 8x5/

p0.516/120kV/135mA/1s is failed, perform standalone Spectral Calibration for 120kV, 40mm, Small
SFOV.

2.3 Confirmation of setLoadHeight functionality

If previously executed setLoadHeight command to set customized load height at foot pedal, confirm
the height is same as before version up. If the height is different, execute setLoadHeight command
again to set correct value.

2.4 UDI Label Attachment

Put UDI label (5720566) in available space around the system label on the gantry that can be visible
from outside and can be scanned by a barcode reader. (Putting it vertically is also OK.)

T OO0

N

(01)00001234567895(111150700(21 JAAAAAYY00001 AA

Both direction is OK.
(label content is just sample.)

XXXXXXXXXXXXXXXXXXXXXXXXXXX

MR

(01)00001234567895(11)150700(21 JAAAAAYY00001AA

UDI:

Figure 2-20 UDI Label
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Appendix A
Default Gateway IP Address Modification

If "0.0.0.0" is used in default gateway field, clear the wrong default gateway information according
to the following procedure.

1.) Delete the wrong default address from Network setting in reconfig.

a.) Open a Unix shell and login as root.
b.) Type: reconfig and press [ENTER].
c.) Go to [Network] tab.
d.) Delete Default Gateway address and leave it blank.
e.) Click [ACCEPT].
f.) When system display a prompt to reboot, select [No].
2.) Delete the wrong default gateway address from /etc/sysconfig/network/routes

a.) Open a Unix shell and login as root.

b.) Type: cat /etc/sysconfig/network/routes

c.) Confirm the following line is included in the file:
default 0.0.0.0 - -

d.) Type: sed -i "/default 0.0.0.0/d" /etc/sysconfig/network/routes and
press [ENTER].

e.) Type: cat /etc/sysconfig/network/routes

f.) Confirm the following line was deleted from the file.
default 0.0.0.0 - -

g.) Type: reboot and press [ENTER].
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Appendix B
How to change the Table height of load foot
pedals

1.) Open a Unix Shell and type the below commands:
{ctuser@hostname}/usr/g/GEfirm/setLoadHeight
then press [Enter], following message pop up:

*** T,oad Hight Tool for HP/VCT ***
Current setting is 210
[1] : 170 mm

[2] : 190 mm
[3] : 210 mm
[0] : quit.

Enter # to Change or quit?

Enter # to Change or quit?

2.) Input the selected number according to customer’s request, then press [Enter]. Below is
example of setting 190 mm:

Enter # to Change or quit?
=2
Succeeded : <190>-> /usr/g/fw/configure/uif characterization.cfg

3.) Execute Scan Hardware Reset.
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